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Introduction 
 
Easy PhotoView allows you an easy method of viewing your photographs and 
pictures as thumbnails, larger individually selected pictures or full screen pictures 
with a double click! A slide show feature is also available. Right click to stop, exit 
and move through the slide show. 
 
A big aspect of Easy PhotoView is the ability to rename those archaic picture 
names once downloaded from your camera. Click on a thumbnail, then change 
the name from 001027605 to FredsWedding. The file extension is automatically 
taken care of for you. You can undo your name as well and as many times as 
necessary UNTIL you select another picture. 
 
Deleting those bad pictures is just as easy. Select a picture then click the menu:  
Edit > Delete. Once deleted, they are deleted.  
 
This manual assumes that you already know how to install standard Windows 
software. Simply run the installation program and follow the prompts. 
 
Minimum Requirements: 
PIII CPU at 600 MHz 
256 mb RAM 
1 mb Hard Drive Space for program files. 
Graphics Card 
Win 32 Operating System, Win 98SE, WinMe, Win2000, WinXP. 
 
Easy PhotoView will open most all common picture/photo graphics types which 
include but may not be limited to: 
 
JPEG images(*.jpg, *.jpeg, *.jpe) 
TIFF images (*.tif, *.tiff) 
GFI fax images (*.fax) 
SGI images (*.bw, *.rgb, *.rgba, *.sgi) 
Autodesk images files (*.cel; *.pic) 
Truevision images (*.tga; *.vst; *.icb; *.vda; *.win) 
ZSoft Paintbrush images (*.pcx, *.pcc) 
Word 5.x screen capture files (*.scr) 
Kodak Photo-CD images (*.pcd) 
Portable pixel/gray map images (*.ppm, *.pgm, *.pbm) 
Dr. Halo images (*.cut, *.pal) 
CompuServe images (*.gif) 
SGI Wavefront images (*.rla, *.rpf) 
Standard Windows bitmap images (*.bmp, *.rle, *.dib, *.wmf, *.emf) 
Photoshop images (*.psd, *.pdd) 
Paintshop Pro images (*.psp) 
Portable network graphic images (*.png) 



Main Easy PhotoView Window 
 
The Main window or from is composed of the Thumbnail Image Viewer on the 
left, the Selected Item Preview Panel and Name edit areas underneath the 
Preview Panel which are on the right. 
 

 
 
The Name edit areas consist of the selected pictures file name directly beneath 
the preview. Below that is an edit box in which you can enter a new name. Below 
that is the picture type. Both grayed edit boxes, top and bottom, are read only 
and provide information to you. There are of course the Rename, Undo and 
Close buttons to the right of the edit boxes. 
 
At the bottom of the main window is an information bar which advises you of the 
number of pictures; the number of pictures you renamed within a directory and 
the number of pictures deleted from a directory. The number of items deleted 
does not count items moved, since they were not deleted, just moved. 
 
To the right of this is a larger area which is an alert area or action area. This will 
advise you of the action being taken or any simple errors that might occur. 
 
Easy PhotoView wants to run in a screen resolution of at least 1024 X 768. If you 
run Easy PhotoView in a smaller resolution, a dialog pops up asking you if you 
want Easy PhotoView to change it to 1024 X 768. If you click ‘Yes’, Easy 
PhotoView will remember your previous settings so when Easy PhotoView 
closes, it can reset your screen back to normal. 
 
See the Easy PhotoView Help System for all the details. You can also press the 
F1 key or right click and click on ‘What’s This” or click any Help button.  



File Menu Item 
 
When clicking the File menu item, the following menu choices appear: 
 
Open Directory 
Reload Directory 
--------------------------------------- 
Send As Email Attachment... 
--------------------------------------- 
Printer Setup... 
Custom Size and Print Layout... 
Standard Print Layout... 
--------------------------------------- 
Exit 
 
Open Directory 
 
Choosing 'Open Directory' will bring up an open directory dialog box which will 
show your computer storage in a hierarchical manner. Use this to select the 
directory that contains the pictures you wish to view. 
 
You must click the 'OK' button to load the directory. Double clicks do not work. 
Cancel closes the dialog and does nothing. 
 
Reload Directory 
 
Choosing 'Reload Directory' will simply reload the current directory. If you 
renamed several pictures, the originals were kept. If you convert a file to a 
different format, again the originals are kept but will not show up in your 
thumbnail list until you reload the directory. After you reload the directory you can 
view and delete those original pictures if desired. 
 
The originals are saved as a safety measure as you never know when you may 
want the original format again. Deleting pictures permanently deletes them. 
Nothing is saved! 
 
Send As Email Attachment 
 
When you select a picture and the click on 'Send as Email Attachment', the 
selected picture will be attached to your default email client's new email 
message. All you have to do is address the email and write a message if you 
want too! 
 
Email Friendly Attachments 
 
When you want to send a picture as an email attachment and if the picture is a 
JPEG, BMP, TIFF or PNG file, Easy PhotoView will pop up a window asking you 
if you want to send this picture as an Email Friendly Attachment. 



What this means is that the picture size will be reduced to make sending them 
easier  and quicker for you as well as the recipient of your email. Just click "Yes" 
when prompted. If you want to keep the original size then click "No". If you click 
"Cancel", nothing will happen and no picture is attached to an email message. 
 
Printer Setup 
 
'Printer Setup...' brings up a standard Windows Setup Printer dialog box. You can 
preset your printers preferences. In all printing , a similar print dialog appears just 
to make certain that you are printing where you want to print. 
Custom Size and Print Layout 
 
When you click on 'Custom Size and Print Layout, a panel overlays the upper 
right hand portion of the application. Within this panel are: 
 
Two small portrait oriented preview images. 
 
A Size Scroll edit box which will increase or decrease the size of the picture by 
percent. This is relative to a standard sheet of paper. 
 
A rotate button. You can rotate in forty five degree increments, right or left. 
(Clockwise/counter clockwise). 
 

 
 
Both horizontal and vertical mirror buttons. Just in case you want to make it look 
really different! 
 
 
 
 
 



Larger buttons for: 
 
• Save Sized. You can save the image's size and appearance with a new 

name. The default name will be that pictures name plus '_Sized', then the file 
extension. 

• Print. Prints the image in the right image window. 
• Print PDF. Will create an Adobe compatible pdf file of the image in the right 

image window. 
• Undo Move. This will undo any position or move from the left image window 

to the right image window. This can be done until you add a new image to the 
left image window. This is done by selecting a new thumbnail. 

• Clear All. Does just that! Starts you over with the selected picture in the 
thumbnail window in the left image window. 

• Close. Closes the panel and returns you to "normal". 
 
When you have selected a picture by clicking a thumbnail, this picture shows in 
the left preview window in its default size and as it relates to a standard printed 
page. You can size the image up or down. You can rotate it or mirror it. When 
you are satisfied, bring your mouse into the right window and click where you 
want the upper left corner of the picture in the left image window to be positioned 
a printed piece of paper. You can move it by dragging it with your mouse or 
clicking a new position. 
 
When you are satisfied, you can click on a new thumbnail. That will appear in the 
left image window and you can repeat the process.  
 
 
Standard Print Layout 
 
Clicking Standard Print Layout opens up a new window which will allow you to 
print out standard picture size images. These are: (in inches) 
8 X 10 
5 X 7 
4 X 6 
2 1/2 X 3 1/2 (wallet size) 
 



 
 
You can print one or two 5 X 7 or 4 X 6 images 
 
You can print from one to nine wallet sized images. 
 
Simply click on and check the size and set the number of pictures you want to 
print. The orientation (for the printer too),  automatically changes to best fit the 
pictures you selected. Click Print and a printer dialog appears. Click Close and 
you will be returned to the main application. 
 
With this window open, you cannot select new thumbnail pictures. You must 
close this window, select a new picture then reopen Standard Print Layout. 
 
Exit 
 
Clicking the 'Exit' menu item closes the program. 
 

 
Edit Menu Item  
 
When clicking the Edit menu item, the following menu choices appear: 
 
JPEG Image Information - EXIF... 
--------------------------------------------- 
Rename Picture 
Undo Rename 
Refresh Thumbnails 
--------------------------------------------- 
View Picture Full Screen... 
Edit Picture... 
--------------------------------------------- 



Rotate Clockwise 
Rotate Counter Clockwise 
Mirror Image 
--------------------------------------------- 
Lighten 
Darken 
Grayscale 
--------------------------------------------- 
Convert to JPEG 
Convert to BMP 
Convert to TIFF 
Convert to PNG 
--------------------------------------------- 
Copy Picture To... 
Move Picture To... 
--------------------------------------------- 
Copy Picture to Clipboard 
--------------------------------------------- 
Delete Picture 
 
 
JPEG Image Information - EXIF 
 
Clicking "JPEG Image Information - EXIF" opens the EXIF Reader. EXIF stands 
for Exchangeable Image File Format, and is a standard for storing interchange 
information in image files, especially those using JPEG compression. Most digital 
cameras now use the EXIF format. The format is part of the DCF standard 
created by JEITA to encourage inter operability between imaging devices. 
 
Use the EXIF Reader to view, add and change hidden information in JPEG files. 
 
Rename Picture 
 
'Rename Picture' will rename the picture to the name entered in the 'Enter 
Picture's New Name' edit box.  
 
 
Undo Rename 
 
Clicking 'Undo Rename' will undo the rename. So, if you decide you don't like the 
name given, you can undo it. However, if you select another picture, the ability to 
undo the last renamed picture is gone. 
 
 
 
 



Refresh Thumbnails 
 
'Refresh Thumbnails' simply refreshes the thumbnail display. It is doubtful that 
this will ever be needed, but to make sure that the changes you have made were 
done, this is a handy tool.  
 
It is similar to Refresh Directory but does not do a reload of all images that may 
have been saved after a rename or conversion to a different format. 
 
View Picture Full Screen 
 
'View Picture Full Screen' will display the selected picture in full screen Slide 
Show Mode. In this mode you can view the next or previous picture, start the 
slide show from this picture and close by using the right mouse button. 
 
See Slide Show Menu for details. 
 
Double clicking of the left mouse button do very little. The only place double 
clicks work are when you double click the selected preview picture in the upper 
right corner of Easy PhotoView. When you double click here, the selected picture 
is viewed in full screen mode. 
 
Edit Picture 
 
Selecting 'Edit Picture' will bring up your default picture editor. This editor could 
be Windows Paint or Adobe PhotoShop. It all depends on what you have 
installed and what program opens any given image. 
 
Rotate Clockwise 
 
'Rotate Clockwise' will rotate the image ninety (90) degrees clockwise. Great for 
those portrait camera shots. 
 
Rotate Counter Clockwise 
 
'Rotate Counter Clockwise' will rotate the image ninety (90) degrees counter 
clockwise. Great for those portrait camera shots. 
 
Mirror Image 
 
'Mirror Image' will reverse the image as if it was being viewed in a mirror. This 
can be handy when you want to change the viewers angle and aspect of the 
scene of person. 
 
 
 
 



Lighten 
 
Lighten will lighten or add more brightness to a JPEG, BMP, TIFF or PNG image. 
In order to lighten your image to a satisfactory level, you may have to click this 
button several times as the increase or brightness, is small. 
 
Darken 
 
Darken will darken and remove brightness to a JPEG, BMP, TIFF or PNG image. 
In order to darken your image to a satisfactory level, you may have to click this 
button several times as the decrease in brightness, is small. 
 
Grayscale 
 
Selecting a picture and clicking 'Grayscale' will convert the current picture, (a 
PNG, BMP, TIFF or JPEG) into a gray scaled picture. Old time black and white 
photography! 
 
Convert to JPEG 
 
'Convert to JPEG' will convert any Easy PhotoView loadable picture into a 
standard JPEG image. 
 
JPEG, Short for Joint Photographic Experts Group, and pronounced jay-peg. 
JPEG is a lossy compression technique for color images. Although it can reduce 
files sizes to about 5% of their normal size, some detail is lost in the 
compression. 
Convert to BMP 
 
'Convert to JPEG' will convert any Easy PhotoView loadable picture into a 
standard JPEG image. 
 
JPEG, Short for Joint Photographic Experts Group, and pronounced jay-peg. 
JPEG is a lossy compression technique for color images. Although it can reduce 
files sizes to about 5% of their normal size, some detail is lost in the 
compression. 
 
Convert to TIFF 
 
'Convert to TIFF' will convert any Easy PhotoView loadable picture into a 
standard TIFF image. 
 
TIFF is an acronym for Tagged Image File Format, one of the most widely 
supported file formats for storing bit-mapped images on personal computers 
(both PC's and McIntosh computers).  
 



TIFF graphics can be any resolution, and they can be black and white, gray-
scaled, or color. Files in TIFF format often end with a .tif extension. 
 
Convert to PNG 
 
'Convert to PNG' will convert any Easy PhotoView loadable picture into a 
standard PNG image. 
 
PNG is short for Portable Network Graphics, and pronounced ping, a new bit-
mapped graphics format similar to GIF. In fact, PNG was approved as a standard 
by the World Wide Web consortium to replace GIF because GIF uses a patented 
data compression algorithm called LZW. In contrast, PNG is completely patent- 
and license-free. The most recent versions of Netscape Navigator and Microsoft 
Internet Explorer now support PNG. 
 
Copy Picture To 
 
Clicking 'Copy Picture To...' will open up the Browse for Directory Dialog window 
which you saw when you first opened a directory. However this time you will see 
that you can make a new directory to copy the selected picture into. 
 
Copy simply copies the picture to another location. 
 
Move Picture To 
 
Clicking 'Move Picture To...' will open up the Browse for Directory Dialog window 
which you saw when you first opened a directory. However this time you will see 
that you can make a new directory to move the selected picture into. 
 
Move deletes the picture from its current directory and copies it to another 
location.  
 
Copy Picture to Clipboard 
 
Clicking 'Copy Picture To Clipboard copies the selected picture to Windows 
clipboard. After you copy it to the clipboard, another application like Microsoft 
Word can paste the copied image.  
Other image programs can accept copied images as well. 
 
Delete Picture 
 
Clicking on 'Delete Picture' will permanently delete the picture. A warning comes 
up advising you of this each time you want to delete a picture. 
 

 
 



Options Menu Item 
 
 
When clicking the Options menu item, the following menu choices appear: 
 
View Slide Show... 
Set Slide Show Interval... 
--------------------------------- 
Incremental Load 
Reduce Memory Usage 
 
View Slide Show 

 
'View Slide Show' will make the first thumbnail picture full screen and start the 
slide show! Right clicking the Slide Show will bring up the Slide Show Menu. 

 
Set Slide Show Interval 

 
'Set Slide Show Interval' sets the number of seconds a picture will show before the next 
picture appears. If you enter something other than a number, Easy PhotoView will warn 
you and reset the number of seconds to 10, which is the default value. 

 
 
Incremental Load 

 
Clicking 'Incremental Load' will add or remove a check mark next to this menu 
item.  
 
IMPORTANT! 
 
If you have a large directory of pictures, over 50 and definitely over 100, make 
sure that Incremental Load is checked. When checked, the loading of pictures 
into the thumbnail viewer is incremental. When you scroll through the thumbnails, 
it loads the pictures as you scroll. 
 
With Incremental Load unchecked, all of the pictures in your directory are loaded 
up into the thumbnail viewer. This is somewhat quicker when you want to scroll 
through a smaller collection of pictures. 
 
Reduce Memory Usage 
 
Easy PhotoView and most picture programs, use a lot of memory. Easy 
PhotoView allows you to try and conserve memory when you load a directory 
with many large pictures. This function in conjunction with Incremental Load will 
keep you from getting an "Out of Resources" or other memory error. 



 
If you do get such an error, try checking Reduce Memory Usage andthen reload 
your picture directory. 

 
 
Help Menu Item 
 
When clicking the Options menu item, the following menu choices appear: 
 
Help... 
Registered To... 
About... 
---------------------- 
Help Type...    HTML Help 
    WinHelp 
 
 
Help 
 
Clicking 'Help...' (under the main menu Help), will bring up the compiled HTML 
Help file starting at the Introduction. 

 
Registered To 
 
Selecting 'Registered To...' will bring up the window which shows the registered 
user of Easy PhotoView. The license number is also visible and is needed for 
any help from JCITS Systems, LLC. 
 
About 
 
Selecting 'About' brings up the About window which shows the software name, 
version number copyright notices and other information about the program. 

 
 
Main Window Right Click Menu 
 
When you use mouse's right button and Right Click on a thumbnail or the larger 
selected image, the following pop up menu will appear: 
 
View Picture Full Screen... 
Edit Picture... 
-------------------------------------- 
Send as Email Attachment... 



-------------------------------------- 
Rotate Clockwise 
Rotate Counter Clockwise 
Mirror Image 
-------------------------------------- 
Copy to Clipboard 
-------------------------------------- 
Delete Picture... 
-------------------------------------- 
Cancel 
 
All of the Main Window Right Click menu items and actions are exactly the same as the 
above Edit menu items. 
 
 

Slide Show Right Click Menu 
 
When you use the mouse's right button and right click during a full screen slide 
show or when viewing an image in full screen mode, the following menu will 
appear: 
 
Stop Slide Show 
Start Slide Show 
------------------------------------------- 
Next Picture 
Previous Picture 
------------------------------------------- 
Set Slide Show Pause Interval... 
------------------------------------------- 
Cancel 
------------------------------------------- 
Close 

 
Stop Slide Show 
 
'Stop Slide Show' simply stops the slide show. To continue, right click the mouse and select Start 
Slide Show. 
 
Start Slide Show 
 
'Start Slide Show' simply starts the slide show after it has been stopped. 
 
 
 
 
 



Next Picture 
 
Right clicking the mouse and bringing up the Slide Show Menu and clicking 'Next 
Picture' at any time will bring up the next picture in sequence within the 
Thumbnail viewer. 
 
Previous Picture 
 
Right clicking the mouse and bringing up the Slide Show Menu and clicking 
'Previous Picture' at any time will display the previous picture in sequence within 
the Thumbnail viewer. 
 
Set Slide Show Pause Interval 
 
'Set Slide Show Interval' sets the number of seconds a picture will show before 
the next picture appears. If you enter something other than a number, Easy 
PhotoView will warn you and reset the number of seconds to 10, which is the 
default value. 
 
Cancel 
 
Cancels or  closes the Slide Show Right Click Menu. 
 
Close 
 
Closes the Slide Show and takes you back to the main Easy PhotoView window. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 



EXIF Reader 
 
The EXIF Reader has an XML panel to the right and below that the Tag Edit box where 
the EXIF tags are edited and viewed. 
 
 

 
 
 
Select Tags 
 
When you click the Select tags button in the EXIF Reader, another window 
opens up with a large selection of Tags in the left hand pane. You select tags in 
the left pane and click an arrow button to move it into the right hand. 
 



 
 
When you click the OK button, the tags are transferred to the edit window of the 
EXIF Reader where you can edit the information and then write this information 
into the JPEG file. 
 
XML 
 
Clicking the XML button in the EXIF Viewer will display the XML text of the 
currently selected JPEG image. This information, as well as the Image Caption, if 
embedded in the file, will display in the XML Panel. 
 
Write Tags 
 
Clicking the 'Write Tags' button will write any tags you selected and/or edited 
back to the selected JPEG image. No image degradation should occur by 
multiple reads and writes to the JPEG image. 
 
Close 
 
Closes the EXIF Reader and returns to the main Easy PhotoView window. 


